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1. Introduction

The PCA9956B evaluation board features LEDs for color mixing, blinking and dimming 
demonstrations. A graphical interface allows the user to easily explore the different 

functions of the driver. The board can be connected in series with other I2C demo-boards 
to create an evaluation system.

The IC communicates to the host via the industry standard I2C-bus/SMBus port. The 
evaluation software runs under Microsoft Windows PC platform.

2. Features

• A complete evaluation platform for the PCA9956B 24-channel Fm+ I2C-bus constant 
current LED driver

• Easy to use GUI-based software demonstrates the capabilities of the PCA9956B

• On-board eight RGB LEDs for visual experience

• Convenient test points for easy scope measurements and signal access

• USB interface to the host PC

• No external power supply required

3. Getting started

3.1 Assumptions

Familiarity with the I2C-bus is helpful, but not required.

3.2 Static handling requirements

3.3 Minimum system requirements

• PC Pentium 60 processor (or equivalent), 8 MB RAM, 10 MB of hard drive space

• One USB port (either 2.0 or 1.1 compatible)

• Windows 98SE, ME, 2000, XP, or Vista

• I2C demonstration board 2005-1 (OM6275) or WIN-I2CUSB board (from 
http://www.demoboard.com)

3.4 Power requirements

The NXP demonstration board I2C 2005-1 and OM13321 hardware obtain power from the 
PC USB port. Care should be taken not to exceed the USB port current capabilities.

CAUTION

This device is sensitive to ElectroStatic Discharge (ESD). Therefore care should be taken 
during transport and handling. You must use a ground strap or touch the PC case or other 
grounded source before unpacking or handling the hardware.
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4. Installation

4.1 I2C demo board 2005-1 and WIN-I2CUSB Lite software

The OM13321 is a daughter card to the OM6275 I2C demo board 2005-1. You may 
download the WIN-I2CUSB Lite Software, the OM6275 user manual UM10206, and find 
ordering information at the NXP web site http://www.nxp.com/demoboard/OM6275.html.

The Win-I2CUSB Lite software from The Boardshop runs on Windows 98SE, ME, 2000, 
and XP and is compatible with any PC hardware having a minimum of a Pentium 
processor and an USB port. The software allows the user to select one of the I2C-bus 
devices on the board from a menu and also provides a Universal mode (I2C Expert mode) 
to allow users to create their own I2C-bus commands with the same I2C-bus devices.

4.2 OM13321 connection to I2C demo board 2005-1

The I2C demo board 2005-1 should be disconnected from your PC before mounting the 
OM13321 board on to it. The OM13321 board has a 9-pin female connector (CON2) that 
connects to the JP1 male connector on the I2C demo board 2005-1 as shown in Figure 1.

With both boards facing you, and with USB connector on the right-hand side as shown in 
Figure 1, connect the OM13321 board to the I2C demo board 2005-1 before connecting 
the USB cable. Once the board is connected, connect the USB cable and start the 
WIN-I2CUSB Lite software. You are now ready to evaluate the PCA9956B.

 

Fig 1. PCA9956B demo board (OM13321) mounting to the I2C demo board 2005-1 (OM6275)
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4.3 OM13321 connection to WIN-I2CUSB hardware adapter board

The Win-I2CUSB board should be disconnected from your PC before connecting the 
OM13321 board on to it. The OM13321 board has a 14-pin male connector (CON4) that 
connects to the 14-pin male connector (J1) on the Win-I2CUSB board as shown in 
Figure 2.

Connect the OM13321 board to the Win-I2CUSB board before connecting the USB cable. 
Once the board is connected, connect the USB cable and start the WIN-I2CUSB Lite 
software. You are now ready to evaluate the PCA9956B.

 

Fig 2. PCA9956B demo board (OM13321) connecting to the WIN-I2CUSB board
UM10709 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2017. All rights reserved.
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5. Hardware description

 

Figure 3 shows the following items on the hardware:

• CON1 (9-pin male connector) is used to daisy-chain to next I2C-bus slave device or 
demo board.

• CON2 (9-pin female connector) is connected to JP1 on I2C demo board 2005-1 as 
master device to drive this demo board.

• CON3 (5-pin male connector) is connected to the PCU9669 or PCA9665 mini board 
as I2C-bus master device to drive this demo board.

• CON4 (14-pin male connector) is connected to J1 on WIN-I2CUSB hardware board 
as I2C-bus master device to drive this demo board.

• J1 selects VDD power for PCA9956B, connected 1-2 for VDD = 5 V and connected 2-3 
for VDD = 3.3 V.

• J5, J8 and J9 to select one of the five (GND, Pull-down, Floating, Pull-up and VDD) 
input levels to address inputs AD[0:2] for a maximum of 125 possible programmable 
I2C-bus slave address.

• LED[0:23] 24-channel output to drive eight RGB LEDs (RGB_LED[1:8]).

• TP2 and TP3 are GND pins for probing use.

Fig 3. PCA9956B demo board (OM13321)
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• TP1 can be connected as external reset signal to RESET pin when J7 is open.

• TP4 can be connected as external output enable signal to OE pin for blinking/dimming 
control when J10 is open.

• All jumpers default setting and function as shown in Table 1.

 

Table 1. Jumper settings for test and evaluation

Jumper Default setting Comment

J1 
(3-pin)

1-2 
(VDD = +5 V)

This jumper is used to select VDD for PCA9956B.

1-2: select +5 V

2-3: select +3.3 V

J2 
(3  2-pin)

1-2 
(REXT = 1 k, 57.3 mA 
at max.)

This 3  2 jumper is used to select REXT (pin 1) value for PCA9956B.

1-2: select REXT = 1 k and maximum output current is 57.3 mA

3-4: select REXT = 1.5 k and maximum output current is 38.25 mA

5-6: select REXT = 2 k and maximum output current is 28.6 mA

J3 
(2-pin)

1-2 
(short)

Short: external 1.1 k pull-up resistor for SDA on PCA9956B.

Open: no external pull-up resistor for SDA on PCA9956B.

J4 
(2-pin)

1-2 
(short)

Short: external 1.1 k pull-up resistor for SCL on PCA9956B.

Open: no external pull-up resistor for SCL on PCA9956B.

J5 
(4  2-pin)

1-2[1]

(VDD)
This 4  2 jumper is used to select quinary input value for AD0 (pin 2).

Open: floating.

1-2: select VDD.

3-4: select pull-up with 31.6 k

5-6: select pull-down with 34.8 k

7-8: select GND

J6 
(2-pin)

1-2 
(short)

Short: connect VDD to pin 38 (power supply) of the PCA9956B.

Open: connect current meter to measure the IDD on PCA9956B.

J7 
(2-pin)

1-2 
(open)

Short: force RESET (pin 35) to GND to reset device.

Open: 10 k pull-up the RESET (pin 35) to VDD and the TP1 can be used as 
external reset input signal.

J8 
(4  2-pin)

1-2[1]

(VDD)
This 4  2 jumper is used to select quinary input value for AD1 (pin 3).

Open: floating.

1-2: select VDD.

3-4: select pull-up with 31.6 k

5-6: select pull-down with 34.8 k

7-8: select GND

J9 
(4  2-pin)

1-2[1]

(VDD)
This 4  2 jumper is used to select quinary input value for AD2 (pin 4).

Open: floating.

1-2: select VDD.

3-4: select pull-up with 31.6 k

5-6: select pull-down with 34.8 k

7-8: select GND

J10 
(2-pin)

1-2 
(short)

Short: force OE (pin 5) to GND, to enable LEDs output.

Open: 10 k pull-up OE (pin 5) to VDD when apply external clock for blinking 
and dimming control on TP4 (test point).
UM10709 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2017. All rights reserved.
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J11 
(2-pin)

External supply voltage 
input to LED0 or all 
LEDs

External supply voltage ( +20 V) input to LED for test only.

The external supply voltage ( +20 V) connects to LED0 only when J19 is open.

The external supply voltage ( 3.3 V) connects to all LEDs when the J19 is short 
and J28 is open.

J21 
(2-pin)

GND input External supply voltage ground input to LED.

J12, J13, J14, 
J15, J16, J17 
(2-pin)

1-2 
(short)

These jumpers are used to connect or disconnect white LEDs (WHT_LED[1:6]) 
on LED0 output for test only.

Open: connected the white LED on LED0 output

Short: bypass the white LED on LED0 output

J18, J24, J26 
(2-pin)

1-2 
(open)

These jumpers are used to test short-circuit for RGB_LED1. 

J18 is used to set short error for Red LED (LED0). 

J24 is used to set short error for Green LED (LED1). 

J26 is used to set short error for Blue LED (LED2).

Open: normal operation for the RGB_LED1.

Short: short one of the RGB_LED1 to test an LED short-error condition in 
EFLAG register.

J19 
(2-pin)

Short This jumper is used to select LED0 supply voltage.

Open: select external  +20 V input from J11 (to LED0 only).

Short: select either internal +3.3 V when J28 is short or external  +20 V 
when J28 is open (to all LEDs).

J20, J23, J27 
(2-pin)

Short These jumpers are used to test open-circuit for RGB_LED1.

J20 is used to set open error for Red LED (LED0).

J23 is used to set open error for Green LED (LED1).

J27 is used to set open error for Blue LED (LED2).

Open: User can connect current meter to measure one of the LED[0:2] 
output current or open one of the RGB_LED1 for detecting an LED open-error 
condition in EFLAG register.

Short: normal operation for the RGB_LED1.

J22, J25 
(2-pin)

Open These jumpers are used to merge the LED[0:2] outputs together for driving 
higher LED current for test only.

Open: normal operation for the RGB_LED1.

Short: When short J22/J25 and open J23/J27 to combine LED[0:2] outputs to 
drive LED0. When short J22 only and open J23 to combine LED[0:1] outputs 
to drive LED0.

J28 
(2-pin)

Short This jumper is used to select LEDs supply voltage.

Open: select external  +20 V input from J11 when J19 is short (for all LEDs).

Short: select internal +3.3 V for LED[1:23] supply voltage when the J19 is 
open or for all LED[0:23] supply voltage when the J19 is short (J11 is 
no input).

Table 1. Jumper settings for test and evaluation …continued

Jumper Default setting Comment
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[1] Default PCA9956B slave address is 0xFAh (AD[2:0] = VDD).

J29, J31, J33 
(2-pin)

Short These jumpers are used to test open-circuit for RGB_LED8.

J29 is used to set open error for Red LED (LED21). 

J31 is used to set open error for Green LED (LED22). 

J33 is used to set open error for Blue LED (LED23).

Open: user can connect current meter to measure one of the LED[21:23] 
output current or open one of the RGB_LED8 for detecting an LED open-error 
condition in EFLAG register.

Short: normal operation for the RGB_LED8.

J30, J32, J34 
(2-pin)

Open These jumpers are used to test short-circuit for RGB_LED8.

J30 is used to set short error for Red LED (LED21). 

J32 is used to set short error for Green LED (LED22). 

J34 is used to set short error for Blue LED (LED23).

Open: normal operation for the RGB_LED8.

Short: short one of the RGB_LED8 to test an LED short-error condition in 
EFLAG register.

TP1 Test Point 1 This TP1 is used to drive RESET input pin 35 from external when J7 is open.

TP2, TP3 Test Point 2/3 These two test points are GND for probe ground connection.

TP4 Test Point 4 This TP4 is used to drive OE input pin 5 from external when J10 is open.

Table 1. Jumper settings for test and evaluation …continued

Jumper Default setting Comment
UM10709 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2017. All rights reserved.
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Fig 4. PCA9956B demo board schematic (part A)
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Fig 5. PCA9956B demo board schematic (part B)
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7. OM13221 demonstration board main components

 

8. PCA9956B evaluation steps

The PCA9956B is controlled by WIN-I2CUsB GUI in Expert mode, as shown in Figure 6.

 

Connect the hardware as described in Section 4. All jumpers are in default setting and 
device address is set to 0xFA on J5, J8 and J9 (set AD[0:2] = VDD) for PCA9956B 
demo board. When you have correctly installed the software and the demonstration board 
hardware is connected and recognized by the computer, start the Win-I2CUSB Lite 
software. As shown in Figure 6, when the demonstration board hardware is correctly 

Table 2. OM13321 demo board main components

Device Description Address/LED Location

PCA9956BTW 24-channel Fm+ I2C-bus 
57 mA / 20 V constant current 
LED driver

0xFAh for I2C demo board U1

PRTR5V0U2AX ESD protection diode - U2

LW-E67C White LED 6 white LEDs WHT_LED[1:6]

LRTB_G6SG RGB LED 8 RGB LEDs RGB_LED[1:8]

LTST-C170GKT Green LED for PCA9956B 
power supply either 3.3 V or 
5 V

1 green LED D1

Fig 6. Drop-down menu selection for Expert mode
UM10709 All information provided in this document is subject to legal disclaimers. © NXP B.V. 2017. All rights reserved.

User manual Rev. 2 — 11 August 2017 12 of 18



NXP Semiconductors UM10709
PCA9956B demonstration board OM13321
connected to the USB port and the computer recognizes it, the message ‘Hardware 
Detected’ is displayed on the bottom of the window.

Switched 3.3 V and 5.0 V power supplies are controlled through the ‘Options’ menu or by 
double-clicking on the 3.3 V or 5.0 V symbols on the bottom of the window. Power 
supplies are disabled by default and you must enable them before using the I2C-bus 
devices on the board. I2C-bus frequency is controlled through the ‘Options’ menu or by 
double-clicking on the frequency symbol on the bottom of the window.

8.1 PCA9956B blinking demo for all RGB LEDs

1. From the ‘Device’ drop-down menus select ‘Universal Modes’, and from the 
subsequent drop-down menu select ‘Expert Mode’ as shown in Figure 6.

2. Copy the ‘PCA9956B RGB LED blinking demo i2c address = 0xFAh’ text file as shown 
below. From the ‘File’ drop-down menus select ‘Open’, and from the ‘open data file’ 
window select the ‘PCA9956B RGB LED blinking demo i2c address = 0xFAh’ text file.

Expert Mode Data File

00,Write,Yes,5,06,Comments: SW reset (00h + 06h) and wait 5 ms
FA,Write,Yes,0,40,3F,Comments: write IREFALL = 0x3Fh = 225ua x 63 = 14 ma per 

channel if Rext = 1k
FA,Write,Yes,800,82,41,10,04,41,10,04,Comments: set LDRx=01 in LEDOUT register for 

all red LEDs on for 800 ms
FA,Write,Yes,800,82,04,41,10,04,41,10,Comments: set LDRx=01 in LEDOUT register for 

all green LEDs on for 800 ms
FA,Write,Yes,800,82,10,04,41,10,04,41,Comments: set LDRx=01 in LEDOUT register for 

all blue LEDs on for 800 ms
FA,Write,Yes,0,81,25,FF,FF,FF,FF,FF,FF,Comments: Set DMBLNK=1 in MODE2 register 

for blinking and LDRx=11 for group blinking controlled by GRPPWM, GRPFREQ
FA,Write,Yes,0,3F,C0,Comments: write PWMALL = 0xC0h to set the PWMALL at 75% duty 

cycles for all LEDs
FA,Write,Yes,2000,88,40,00,Comments: write GRPPWM=0x40h for duty cycle (ON/OFF 

ratio in 25%) and GRPFREQ= 0x00h (66mS for blinking period) wait for 2 s
FA,Write,Yes,2000,88,80,03,Comments: write GRPPWM=0x80h for duty cycle (ON/OFF 

ratio in 50%) and GRPFREQ= 0x03h (0.26 s for blinking period) wait for 2 s
FA,Write,Yes,2000,88,C0,06,Comments: write GRPPWM=0xC0h for duty cycle (ON/OFF 

ratio in 75%) and GRPFREQ= 0x06h (0.46 s for blinking period) wait for 2 s
FA,Write,Yes,3000,88,F0,09,Comments: write GRPPWM= 0xF0h for duty cycle (ON/OFF 

ratio in 94%) and GRPFREQ=0x09h (0.65 s for blinking period) wait for 3 s
FA,Write,Yes,0,81,Comments: set control register start 01h to read MODE2 register
FA,Read,Yes,0,25,Comments: read MODE2 register, check the OVERTEMP (bit7=0) and 

ERROR (bit6=0)
FA,Write,Yes,0,40,00,Comments: write IREFALL = 00h to turn off all LEDs
Sequence:01,02,03,04,05,06,06,07,08,09,10,11,12,13,14

3. After opening the ‘PCA9956B RGB LED blinking demo i2c address = 0xFAh’ text file, 
the WIN-I2CUSB GUI in Expert mode screen will be displayed as shown in Figure 7.

4. Click the ‘Send All’ button. All the valid messages on the screen will be sent in order of 
the row number. The action will be performed one time.
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8.2 Test of LED open or short error detection

The PCA9956B is capable of detecting an LED open or short condition at its open-drain 
LED outputs. Users will recognize these faults by reading the status of a pair of error bits 
(ERRx) in error flag registers (EFLAGn) for each channel.

The user can poll the ERROR status bit (bit 6 in MODE2 register) to check if there is a 
fault condition in any of the 24 channels. The EFLAGn registers can then be read to 
determine which channels are at fault and the type of fault in those channels.

1. Copy the ‘PCA9956B Open or Short test’ text file as shown below. From the ‘File’ 
drop-down menus select ‘Open’, and from the ‘open data file’ window select the 
‘PCA9956B Open or Short test’ text file.

Expert Mode Data File
00,Write,Yes,5,06,Comments: software reset
FA,Write,Yes,0,A2,80,80,Comments: set current to 50% of max in IREF0/IREF1
FA,Write,Yes,0,02,05,Comments: set LED0 and LED1 are fully ON
FA,Write,Yes,1,01,15,Comments: Clear all error status bits in EFLAGn registers by 

writing bit4=1 in MODE2
FA,Read,Yes,0,05,Comments: read ERROR status (bit6) in MODE2
FA,Write,Yes,0,41,Comments: set EFLAG0 register address
FA,Read,Yes,0,00,Comments: Read EFLAG0 status (bit1/0 for LED 0 and bit 3/2 for 

LED1 error status)
FA,Write,Yes,1,01,15,Comments: Clear all error status bits in EFLAGn registers by 

writing bit4=1 in MODE2
FA,Write,Yes,0,A2,00,00,Comments: set output current to zero in IREF0/IREF1
Sequence:01,02,03,04,05,06,07,08,09

2. After opening the ‘PCA9956B Open or Short test’ text file, the WIN-I2CUSB GUI in 
Expert mode screen will be displayed as shown in Figure 8.

3. Click the ‘Send All’ button. All the valid messages on the screen will be sent in order of 
the row number. The action will be performed one time.

Fig 7. Message data in Expert mode to demonstrate all RGB LEDs for blinking
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4. To verify the read data on message line 5 for ERROR status and line 7 for EFLAG 
status.

5. To open the J20 and J23 for open-circuit test on LED0 and LED1, repeat steps 3 and 
4 to find the error report in message line 5 and line 7.

6. To short the J18 and J24 for short-circuit test on LED0 and LED1, repeat steps 3 and 
4 to find the error report in message line 5 and line 7.

 

9. Support

For support, please send an e-mail to: i2c.support@nxp.com

10. Abbreviations

 

Fig 8. Example of Open or Short-circuit test for LED0 and LED1

Table 3. Abbreviations

Acronym Description

ESD ElectroStatic Discharge

Fm+ Fast-mode Plus

GUI Graphical User Interface

I2C-bus Inter-Integrated Circuit bus

IC Integrated Circuit

LED Light Emitting Diode

PC Personal Computer

PWM Pulse Width Modulator

RAM Random Access Memory

RGB Red/Green/Blue

SMBus System Management Bus

USB Universal Serial Bus
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12. Legal information

12.1 Definitions

Draft — The document is a draft version only. The content is still under 
internal review and subject to formal approval, which may result in 
modifications or additions. NXP Semiconductors does not give any 
representations or warranties as to the accuracy or completeness of 
information included herein and shall have no liability for the consequences of 
use of such information. 

12.2 Disclaimers

Limited warranty and liability — Information in this document is believed to 
be accurate and reliable. However, NXP Semiconductors does not give any 
representations or warranties, expressed or implied, as to the accuracy or 
completeness of such information and shall have no liability for the 
consequences of use of such information. 

In no event shall NXP Semiconductors be liable for any indirect, incidental, 
punitive, special or consequential damages (including - without limitation - lost 
profits, lost savings, business interruption, costs related to the removal or 
replacement of any products or rework charges) whether or not such 
damages are based on tort (including negligence), warranty, breach of 
contract or any other legal theory. 

Notwithstanding any damages that customer might incur for any reason 
whatsoever, NXP Semiconductors’ aggregate and cumulative liability towards 
customer for the products described herein shall be limited in accordance 
with the Terms and conditions of commercial sale of NXP Semiconductors.

Right to make changes — NXP Semiconductors reserves the right to make 
changes to information published in this document, including without 
limitation specifications and product descriptions, at any time and without 
notice. This document supersedes and replaces all information supplied prior 
to the publication hereof. 

Suitability for use — NXP Semiconductors products are not designed, 
authorized or warranted to be suitable for use in life support, life-critical or 
safety-critical systems or equipment, nor in applications where failure or 
malfunction of an NXP Semiconductors product can reasonably be expected 
to result in personal injury, death or severe property or environmental 
damage. NXP Semiconductors accepts no liability for inclusion and/or use of 
NXP Semiconductors products in such equipment or applications and 
therefore such inclusion and/or use is at the customer’s own risk.

Applications — Applications that are described herein for any of these 
products are for illustrative purposes only. NXP Semiconductors makes no 
representation or warranty that such applications will be suitable for the 
specified use without further testing or modification. 

Customers are responsible for the design and operation of their applications 
and products using NXP Semiconductors products, and NXP Semiconductors 
accepts no liability for any assistance with applications or customer product 
design. It is customer’s sole responsibility to determine whether the NXP 
Semiconductors product is suitable and fit for the customer’s applications and 
products planned, as well as for the planned application and use of 
customer’s third party customer(s). Customers should provide appropriate 
design and operating safeguards to minimize the risks associated with their 
applications and products. 

NXP Semiconductors does not accept any liability related to any default, 
damage, costs or problem which is based on any weakness or default in the 
customer’s applications or products, or the application or use by customer’s 
third party customer(s). Customer is responsible for doing all necessary 

testing for the customer’s applications and products using NXP 
Semiconductors products in order to avoid a default of the applications and 
the products or of the application or use by customer’s third party 
customer(s). NXP does not accept any liability in this respect.

Export control — This document as well as the item(s) described herein 
may be subject to export control regulations. Export might require a prior 
authorization from competent authorities.

Non-automotive qualified products — Unless this data sheet expressly 
states that this specific NXP Semiconductors product is automotive qualified, 
the product is not suitable for automotive use. It is neither qualified nor tested 
in accordance with automotive testing or application requirements. NXP 
Semiconductors accepts no liability for inclusion and/or use of 
non-automotive qualified products in automotive equipment or applications.

In the event that customer uses the product for design-in and use in 
automotive applications to automotive specifications and standards, customer 
(a) shall use the product without NXP Semiconductors’ warranty of the 
product for such automotive applications, use and specifications, and (b) 
whenever customer uses the product for automotive applications beyond 
NXP Semiconductors’ specifications such use shall be solely at customer’s 
own risk, and (c) customer fully indemnifies NXP Semiconductors for any 
liability, damages or failed product claims resulting from customer design and 
use of the product for automotive applications beyond NXP Semiconductors’ 
standard warranty and NXP Semiconductors’ product specifications.

Evaluation products — This product is provided on an “as is” and “with all 
faults” basis for evaluation purposes only. NXP Semiconductors, its affiliates 
and their suppliers expressly disclaim all warranties, whether express, implied 
or statutory, including but not limited to the implied warranties of 
non-infringement, merchantability and fitness for a particular purpose. The 
entire risk as to the quality, or arising out of the use or performance, of this 
product remains with customer.

In no event shall NXP Semiconductors, its affiliates or their suppliers be liable 
to customer for any special, indirect, consequential, punitive or incidental 
damages (including without limitation damages for loss of business, business 
interruption, loss of use, loss of data or information, and the like) arising out 
the use of or inability to use the product, whether or not based on tort 
(including negligence), strict liability, breach of contract, breach of warranty or 
any other theory, even if advised of the possibility of such damages. 

Notwithstanding any damages that customer might incur for any reason 
whatsoever (including without limitation, all damages referenced above and 
all direct or general damages), the entire liability of NXP Semiconductors, its 
affiliates and their suppliers and customer’s exclusive remedy for all of the 
foregoing shall be limited to actual damages incurred by customer based on 
reasonable reliance up to the greater of the amount actually paid by customer 
for the product or five dollars (US$5.00). The foregoing limitations, exclusions 
and disclaimers shall apply to the maximum extent permitted by applicable 
law, even if any remedy fails of its essential purpose.

Translations — A non-English (translated) version of a document is for 
reference only. The English version shall prevail in case of any discrepancy 
between the translated and English versions.

12.3 Trademarks
Notice: All referenced brands, product names, service names and trademarks 
are the property of their respective owners.

I2C-bus  — logo is a trademark of NXP B.V.
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